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Software component 

The whole software contains a CD and an operation instruction. 

The CD: Contains all the installation procedure. 

The instruction: Introduce the operation of the software. 

Installation 

HGO software can be installed directly from the CD or the hard disk. 

It needs at least 32M internal storage and 200M hare disk. This 

software can be operated in the environment below: 

 Microsoft ® Windows 95, 97, 98,SE, ME 

 Microsoft ® Windows NT Service Pack 4 and the latter version 

 Microsoft ® Windows 2000/XP 

 Microsoft ® Windows7 

 Microsoft .Net Frameworks 2.0 

Installation steps: 

Run the program “HGO.msi” which in the installation directory. 

 
Figure 1-1 
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Click Next: 

 
Figure 1-2 

Choose an installation path and then click Next： 

 
Figure 1-3 
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Click Install: 

 
Figure 1-4 

Wait until the entire program is installed successfully, then you will 

see the interface below: 

 
Figure 1-5 
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There will be a Hi-Target Geomatics Office file generated 

automatically in the Start menu, and this file contains several icons 

(look at the picture below). 

 
 Figure 1-6 

Uninstall 

There are two ways to uninstall the installed software: 

1. Just Select Start\Program\HI-Target Geomatics Office\Uninstall 

 
Figure 1-7 

2. Select “Start\Setting\Control Panel”, chose Control Panel, then 

Add/Remove Programs, the “Add/Remove Programs” Properties 

dialog appears. Click on Add/Remove get a pop-up window as figure 

1-8. 

Click Uninstall 
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Figure 1-8 
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In this chapter, we will explain the general procedure via HGO 

software to resolve the data of static, dynamic. You can find details or 

advance usage in the following chapters. This chapter helps you to 

complete data processing rapidly. 

Static GPS Data Processing 

Create a new project 

Run HGO software, click button in the navigation field to create a 

new project (Figure 2-1). If necessary, set the project name and route 

which folder store the project files. Otherwise, the files will be stored 

in the installation folder (Figure 2-2).Click OK button to finish the 

project creation. 

 
Figure 2-1 
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Figure 2-2 

Set Property of the Project 

Follow the wizard or click on button in the navigation field, the 

Project Properties dialog appears as Figure 2-3 .You can set the detail 

info of the project. Generally, you need to set the tolerance item. 

 
Figure 2-3 
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Set up Coordinate System 

It is necessary to set up the coordinate system parameters for a new 

project. Click on button in the navigation field, the following 

dialog appears as Figure 2-4. Generally, setting coordinates just need 

to set Ellipsoid, Projection and Convertion item. The details of 

coordinate parameter setting you can find in the following chapter. 

 
Figure 2-4 

Import Static Data  

Once you have set up your HGO software project, you can import data 

into it. 

Chose  Import Files item in the navigation field, we can load on 

GPS data observation files (Figure 2-5) . Select static or auto mode in 

the dialog, click on Select Files button or double-click to enter the file 

selection interface, as Figure 2-6: 
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Figure 2-5 

 
Figure 2-6 

Chose static files, as Figure2-7, you can press CTRL or SHIFT key to 

select a few items, click on Open, import the data(Figure 2-8): 

Import data files 
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Figure 2-7 

 
Figure 2-8 

After importing the data, HGO software can automatically generate 

baselines, repeat baseline, sync loop, asynchronous loop and so on 

(Figure 2-9). 
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Figure 2-9 

Edit Files Information 

After loaded on all the data, system will display all observation files. 

Chose the tree type directory of Observation files and switch the tab to 

Obs-files in the work field, and then you can view the list of all files 

(Figure 2-10). Double click on one, enter the editor window. Make 

sure the height antenna, the type of receiver and antenna are right 

(Figure 2-11).Do this for all files. 

 
Figure 2-10 
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Figure 2-11 

Baseline Processing 

After loaded on all the data, system shows all the GPS baseline 

vectors and the plan view shows all the information about the GPS 

network.    

Then you can process the baseline, click Process Baseline -> 

button in the navigation field to process baselines, the system will 

process all the baselines according to the default settings (Figure 2-12) 

 
Figure 2-12 

During the processing, program shows the schedule of the baselines as 

Figure 2-13, we can find the processing information about each 

baseline processing in the list of Baselines.    
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Figure 2-13 

The time of baseline solution depends on the number of the baseline, 

the time of the observation, the baseline processing setting, and the 

rate of the computer. Completing all the baseline, the baseline solution 

result displays in the baseline list window. The color of the previous 

unsolved baseline in the map changes from light to dark green. 

(Figure2-14)  

 
Figure 2-14 
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Adjustment Setting 

After the baseline processing, it is need to check the adjustment result. 

But for this simple  section, we suppose all the baselines are good. 

Generally, if the observation condition is good, we can process all the 

baselines once successfully.    

It is needed to delete part of a baseline, according to the quality of 

synchronous observation after the solution. Here we will not explain it, 

too. 

Now we begin to prepare the network adjustment. 

First we should set some points as control points. Switch work field to 

Points tab, select one site and right-click on the selected site. Then 

chose Set as Control Point item ,the selected point will be add to the 

list of control points automatically(Figure 2-15). 

 
Figure 2-15 
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Switch work field to Points tab, you will find this point which you set 

as control point (Figure 2-16).Double click on one point name, you 

can edit these points as Figure 2-17.Do this for all control points. 

 
Figure 2-16 

 
Figure 2-17 

Network Adjustment 

Click on  button in the navigation field in the navigation field, 

enter the adjustment setting window(Figure 2-18).After setting 

adjustment options, you can choose Adjust item , then Network 

Adjustment tool window appears as Figure 2-18. 
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Figure 2-18 

 
Figure 2-19 

Click on Auto Adjust button, it will do free 3D adjustment, constraint 

3D adjustment under WGS84 ellipsoid, constraint 3D adjustment and 

2D adjustment under local ellipsoid according to the settings above. It 

also can generate adjustment result list.  
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Report 

Click on button in the navigation field, you can set output items 

which you want to view in the adjustment report and the format of 

adjustment report (Figure 2-20).  

 
Figure 2-20 

Then chose , select one result which you want to view in the 

adjustment result lists, click on Get Report button. It will generate 

adjustment report as Figure 2-21.The context of report ,you can find in 

following chapter. 

 
Figure 2-21 
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At this time, the processing is over. You can chose in the 

navigation field to export the solution result. 

Next we will introduce how to process dynamic GPS data.  

Dynamic Route Processing 

Dynamic GPS data processing has three solving mode: RTD, 

Stop&Go, PPK (Post Process Kinematic).The difference of them can 

be find in chapter 5. 

Import Data 

First we create a project as static GPS data processing. Because during 

the outdoor observation, one dynamic baseline includes two files at 

least, one is static observation file and another is dynamic observation 

file，they are defined to be synchronous. When you import the 

observation data files with dynamic and static mode, make sure which 

file is static file and dynamic file. Generally, data files exported from 

rover is dynamic files, from base or CORS is static file. If you import 

data files by auto mode, you just need to import all observation data 

files (Figure 2-23). 

 
Figure 2-22 
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Figure 2-23 

Set Property of Observation Files and Points 

Set the Mode of Observation Files 

If you import data files by auto mode, you need to convert the data file 

which is exported by rover to dynamic mode. Click Switch to 

Static/Kinematic menu in the pop-up menu as Figure 2-24. 

 
Figure 2-24 

Edit the Coordinate of Points 

Chose the Points node of tree list in the left of work field, select the 

base point (reference station) and double click on it, Station window 

displays as Figure 2-25.Edit and confirm the coordinate of the station. 
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Notice: The coordinate of reference station must be 

accurate, or solving result is not accurate. 

 

 
Figure 2-25 

Add Stop&Go RSP File  

Stop&Go RSP file is a time file which record the start time and end 

time of a stop stage in field work. If you do stop&go or PPK 

processing, you can add stop&go RSP file to dynamic observation file. 

Certainly, if you don’t add stop&go RSP file, program will also do 

processing, in fact, the result is just pure dynamic solution result and 

you only obtain go stage solution result in the repot. Chose Stop&Go 

RSP File menu item in the pop-up menu as Figure 2-26, add 

corresponding stop&go RSP file. 

Notice: Because observation file is divided into stop 

stage files by RSP file, the correctness of RSP 

file is very important. Make sure that the 

observation time of RSP file is consistent with 

observation files. 

 

 

http://dict.youdao.com/search?q=corresponding&keyfrom=E2Ctranslation
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Figure 2-26 

Dynamic GPS Data Solution 

After the operation of the above, next we will process baselines. 

Processing Settings 

Chose the Baselines node in the tree list view, then you can see the 

detail view switch to Baselines tab page. Right click on one or more 

baselines. Chose Process Options menu item in the pop-up menu 

(Figure 2-27), enter the following window as Figure 2-28.  

 
Figure 2-27 

 

 

 



Quick Start Guide 

24 

 

Notice: If you do Stop&Go processing, we suggest you 

setting the minimum epoch to 180s. If the 

minimum epoch is too small, the integer 

ambiguity will not be fixed. 

 
Figure 2-28 

Chose Dynamic tab page in the above window, set the mode of 

procession as Figure 2-29. 

After you finish your settings, click on Apply to button to complete 

setting and back to work interface. 
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Figure 2-29 

Process Baseline 

Chose Process Line menu item in the pop-up menu, begin to process 

the selected baselines. You can see solution status on the process 

status bar as Figure 2-30. 

 
Figure 2-30 

After processing, you can view the plan map of dynamic route. The 

green color represent fixed solution, yellow is float, red is single.  

Solution Type 
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Figure 2-31 

Click on button, the map display as the following Figure 2-32.The 

map just display the stop points. 

 
Figure 2-32 

Report 

Chose Process Line menu item in the pop-up menu to generate the 

solution result report. 
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Figure 2-33 

Thus, we process a static baseline control network already. You can 

chose  in the navigation field to export the solution result. 
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HGO Main Program 

Run HI-Target Geometrics office Software Package in the Start menu, 

or directly run  Icon, then it enters the main program. Now you 

can get the window as Figure 3-1. This window includes Menu bar, 

Tool bar, Status bar, Navigation field, Message field, Work field and 

so on. 

 
Figure 3-1 

Chose file menu or chose a project in the Project Navigation Filed, 

open a project, if you chose GPS(China) Pro which is a demonstration  

project, you will find the window as Figure 3-2. 

 
Figure 3-2 

Title Bar 

Tool Bar 

Work Field 

Navigation Field 

Status Bar 

Message Field 
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According to the design, user interface include fields as following: 

 

Title bar: Title bar can help you quickly determine the type of current 

application. And you can do a few programs controlling, such as, 

Maximum, Minimum and Exit program. If you open a project, it will 

display the project name. 

Menu bar: The list menu is an important part of any type window. It 

supplies many commands to create engineering files, process data, and 

manage data. 

Tool bar: Provide majority common shortcut keys to fast operation. 

Status bar: Display a few guides about current operations.  

Work field: It is the user’s main work field, generally includes every 

type views related to the project.  

Navigation field: Provide common shortcut keys for fast operation. 

Message field: Output message of processing. 

Next, we explain all the operations to the main program. 

Menu and Toolbars 

Menu 

The main menu of the program is consists of File, Baseline, Adjust, 

Tools, Options, Help. Every menu item has a window shortcut key. 

The menu items provide the operation to complete most of the data 

processing work and cover the main processing steps. 

 
Figure 3-3 

Tool Bar 

You can achieve a few common operations and accelerate the rate via 

the Toolbars in the main program. It includes create new project, open 



 HGO Data Post Processing Software Package Manual 

31 

project, save project, import data, export data, get default view (Figure 

3-4). 

 
Figure 3-4 

Navigation Field 

The navigation field is a quick entrance of menu bar, you can show or 

hide it. It is used to make user’s operation faster. 

 
Figure 3-5 

Plan View 

Plan view in the work field mainly displays the added information, 

such as, site, baseline, error ellipsoid, scale, grid and so on. 



Program Main Interface 

32 

 
Figure 3-6 

Observation Site 

In the map, ▲ means that GPS observation site have been associated 

with the control site. ●  means that GPS observation site is a 

common site. 

Baseline 

The static baseline is marked by arrowhead line, and the arrowhead 

can be hidden. When it is not resolved, or don’t be resolved, the 

baseline is gray.    

Move the mouse, when you click on the site or baseline, the site or the 

baseline will be lighted as Figure 3-7. 

 
Figure 3-7 
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Error Ellipsoid 

After finishing baseline processing the error ellipsoid and the height 

residual of baselines will be displayed with green color. It shows the 

baseline resolving quality. 

Graphical Operation Tools 

Graphical operation tools is on the upper right corner of the plan view. 

Click on the tool firstly, then click on the network graph, you will 

achieve the corresponding graphical operation. 

 
Figure 3-8 

 Select Button: Select the site and baseline of the network graph. 

 Square Select Zoom Button 

 Zoom Out Button 

 Zoom In Button 

 Full Screen Button 

 Pan Move Button 

 Grid Reference Line Displayed Button 

 Error Ellipse Displayed Button 

 Rover Point Displayed Button 

 

Setting the Drawing Mode of Plan Grid Reference Line 

Chose Options->Customize menu item, enter custom configuration 

dialog (Figure 3-9).You can set the drawing mode of plan grid 

reference line as plan or geodetic coordinate by setting the second 

item. 
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Figure 3-9 

Tree List View of Work Field 

The left of the work field is a tree list view. It is used to manage all 

context of the project, including points list, baselines list, synchronous 

loop list, asynchronous loop list, observation files list, ephemeris files 

list. Click on one node in the list, the detail view which is in the work 

field will display some related information according to the selected 

node. Then For example, click on Points node, the detail view will 

display Project Plot, Points and Control Points, and position on Points 

tab (Figure 3-10). 

 
Figure 3-10 

Tree List View 

Detail View 
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Detail View of Work Field 

The detail view of work field contains several tabs, every tab will 

display or hide to get different display combinations according to the 

selected node of tree list. 

Notice: The tabs of detail view will change automatically 

according to the selected node of tree list, users 

don’t need to search. 

Pop-up Menu of Detail View  

Chose one item in the detail view, and right click on it, the pop-up 

menu will display as Figure 3-11. 

Notice: Pop-up menu will change as the tab content 

changes. 

 

 
Figure 3-11 

Property Window 

Chose Edit item in the pop-up menu, you can edit properties of the 

selected item. Property Window is different as different tab of detail 

view.  
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Figure 3-12 
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Hi-Target Geomatics Office Software Package is managed via the 

Object Oriented method, so  no matter to do point positioning or do 

static baseline processing or dynamic route processing even to do 

network adjustment, you should create a new project or open an 

established project firstly. 

Create a new project following these steps:  

1.  Create a new project firstly, enter the project name and the save 

path; 

2.  Enter property and tolerance of the project; 

3.  Enter the coordinate parameters in the coordinate management 

system 

After this, you can do the next operations.  

Create a New Project 

Set the Property of a Project 

Click Project menu / Project property or click  in the navigation 

field to set the property of the project. 

Base Information 

The basic Information all display in the report of the network 

adjustment. 
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Figure 4-1 

Tolerance 

The tolerance of project is very important. You can choose using 

national standard or custom define standard. Many tests are conducted 

according to the tolerance settings during data processing. The details 

precision dilution can be found in the Global Position System (GPS) 

Survey Criterion. 
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Figure 4-2 

Advance 

Advance setting decide the control item of data processing. Such as 

using first four characters of *ZHD file as the point name of 

observation file, Minimum Time span of Static Baseline and Dynamic 

Baseline. 
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Figure 4-3 

Set the Coordinate Parameters 

Click File menu->Coordinate System item or click  in the Project 

navigation field to set the coordinate parameters. Generally, you can 

set coordinate parameters by following common three steps. 

Set Ellipsoid 

Ellipsoid tab page can set the Source Ellipsoid and Target Ellipsoid. 

You just need to select the ellipsoid name in the Ellipsoid combo box. 

If the ellipsoid can’t be found in program, please contact our 

technicians and provide parameters of the ellipsoid. 
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Figure 4-4 

Set Projection 

Projection tab page includes projection method and parameters of 

projection. Select the projection method and enter the corresponding 

parameters. If the projection method is not available, please contact 

our technicians and provide the calculation method and corresponding 

parameters. 

 
Figure 4-5 
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Set Conversion 

Convert tab page is used to set parameters of datum conversion. Select 

one model in the Model combo box and enter the corresponding 

parameters. If you have no model parameters, you can use our Coord 

Tool to calculate. If the model is not available, please contact our 

technicians and provide the calculation method and corresponding 

parameters. 

 
Figure 4-6 

The files will be created during a project processing. These files are 

saved in the project route and subdirectory. When we view the project 

subdirectory (Figure 4-7), we can find a project file “*.HGO” and six 

subdirectories created in the project directory. Adjust subdirectory is 

used for save the information during adjustment processing, Baseline 

subdirectory is used for keep the baseline processing information, 

EphBinData subdirectory is used for save the Ephemeris data, 

ObsBinDat subdirectory is used for save the observation data, Report 

subdirectory is used for save the report document, Rinex subdirectory 

is used for save the rinex files transformed from the observation files.  
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Figure 4-7 

So all the data and the processing information are saved in the same 

subdirectory, when completed this project, you can pack and save the 

whole directory and the corresponding subdirectory.  In addition, the 

project folder can be transplanted from one computer to another 

computer and be opened. 

Observation File 

The data formats exported by the GPS receiver are NEMA0183 and 

the original survey data. In the term of HGO (Hi-Target Geomatics 

Office) Software Package, it needs the original survey format. The 

original surveying data of most GPS receivers is binary system, whose 

formats are differently.  

HGO Software Package can process the defined format, and also 

process other data format of several common GPS receiver, and it 

supports RINEX text format, too. 

The Content of the Observation File 

The observation files mainly save the original observation data of each 

ephemeris recorded by the GPS receiver. Each ephemeris includes 

observation time and the satellite information of every channel, C/A 

code, P1 code pseudo-range, P2 code pseudo-range, L1 carrier phase, 

L2 carrier phase. For the static observation files of the HGO Software 

Package, it is necessary to include the observation time, C/A code 

pseudo-range, L1 carrier phase; For dynamic observation files it is 

necessary to include the observation time and the C/A code 

pseudo-range. 
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The observation files include information besides the above of the 

point information, initial coordinate and the ephemeris information 

correlative the observations files.    

In order to process stop&go data, stop& go time files is necessary 

except for static data file. It includes the start observation time and 

end observation time of a point. 

The observation files can be expressed as the follow Figure 4-8: 

 
Figure 4-8 

The ZHD/GNS Format Observations of Hi-Target Receiver 

The observation files of the ZHD or GNS Format defined by 

Hi-Target all include the original observations, ephemeris data, the 

coordinate of the start and end point, several editions include the point 

information, rout information of the dynamic capture record. 

The Observation in the RINEX Format 

In order to process the data unified collected by different types of 

receivers, the RINEX Format data which is a universal data transform 
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format is established. The RINEX Format is brought forward by the 

Berne Univ.Astro.Inst in Switzerland, which has become a standard 

format programming all the manufacturers, schools and institutes. And 

currently the main GPS receivers are all able to transform the 

observations to the RINEX format.  

Other Observation Format 

HGO also support other observation format, such as SP3 format. 

Data Preparation 

The HGO Package has the ability to process a few types of data 

format.  

Generally, you should do the next steps before processing a group of 

GPS observations: 

Import Data 

Click File menu->Import or click in the navigation field. 

 
Figure 4-9 

At the right of the dialog, there is an Observation file mode combo 

box, it includes Auto, Static, Dynamic three modes.  

Auto: Import both static and dynamic data file. The mode of all 

imported files is static. 

Static: Import static data file. 
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Dynamic: Import dynamic data files which is exported by rover. 

Import folder, the HGO Package can import all files which meet the 

conditions automatically. 

If you select import GNS data files, the program will pop-up a file 

dialog as Figure 4-10.File dialog will be transferred to the path of 

current project and lists all files with corresponding extension. You 

can select one file or multiple files at once. 

 
Figure 4-10 

File import only imports observation files. In fact, at the same time, it 

imports the corresponding ephemeris files. For the files in the 

ZHD/GNS format, the observations file and the ephemeris are 

included in one file, so they are imported at the same time. For other 

format, the observation file and the ephemeris may be not in the same 

file, then they should be saved in one directory, and the software will 

automatically distinguish and import the ephemeris by the format of 

the file. Or else, the user should enter the ephemeris in the post 

processing. 

After imported the files, the soft will get the observation station from 

the observation files  and automatically assemble to the static 

baseline and the dynamic route by the observation time spans, you 

will find explanation in the following (Figure 4-11). 
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Figure 4-11 

Name of Observation File  

The HGO Software Package usually distinguishes different files via 

the file’s name. The common observation file is consists of 8 file 

names and their extend name. For example a GNS observations file is 

named as ABCD1234.GNS.    

In a project several files have the same name is unallowable. For 

example, there are two files with the same name ABCD1234.GNS in a 

project, which is forbidden. You can name the observations files in 

different ways.   

ZHD/GNS Observations Files 

For the file name of the *.ZHD or *.GNS static observations files of 

Hi-Target receiver it is consists of 8 characters in the form:  

 !!!!$$$#. ZHD 

 !!!!$$$#. GNS 

Point Name 

In the observation names, the front four! Denote the point name, the 

point name can be characters or figures, and also can be two Chinese 

characters. After downloading the observation files, the software will 

analyze point name automatically, if the number of the characters in 
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the point name fewer than four, it will be add underline before the 

name to four characters via the collection software and or the data 

transferring software by the HD8200. For example point name A will 

become “___A”.    

The after three figures and an English character or figures “$$$#” 

denote the period of time. The $$$ express the Day in a Year, that is 

the order of the observation day in a year. See Appendix B about the 

Day in a Year, the # expresses the observation sequence of a day 

which can be denoted by 1, 2, 3 … A, B, C,….    

For the ZHD/GNS dynamic observation files of the HGO, the file is 

named as the same way, but the observation site name is of no 

meaning which is only be used for identifying the different files. 

Rinex Observations Files 

The name of the RINEX Format is as the following: 

 Observations file: !!!!$$$#. yyO 

 Ephemeris file: !!!!$$$#. yyN 

It is obvious that the name regulation of the RINEX file is like to the 

ZHD/GNS file, what different is that yy denotes the year of 

observation. The MARKER NAME in the RINEX form has the name 

of the observation station, if it is empty, the software will resolve the 

observation file’s name in the way of reading file name in the 

ZHD/GNS file, then form the site information.   

If some files with the RINEX format are not named as this rule, you 

should rename the file before importing it into the HGO Software 

Package. 

Other Observation Files 

See correlative information about the other observation files. 

Pop-up menu of the Observation File 
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Chose one file in the Obs-Files tab of the detail view, right click on it, 

then the pop-up menu will display as Figure 4-12.Thus, and you can 

operate observation by clicking these menu items. 

 
Figure 4-12 

Property of Observation File  

Chose one file in the Obs-Files tab of the detail view, right click or 

double click on it, and chose Edit item in the pop-up menu. You can 

edit the property of the selected observation file on following window 

as Figure 4-13. 

 
Figure 4-13 
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Single Point Positioning Result of Observation File 

Choose one file in the Obs-Files tab of the detail view, right click on it, 

and chose Single Positioning Result item in the pop-up menu. Then 

Single Point Position tab will be activated, the single point positioning 

result of observation file displays in the plan view as Figure 4-14. 

 
Figure 4-14 

The Data Track Map of Observation  

Choose one file in the Obs-Files tab of the detail view, right click on it, 

and chose Data Track item in the pop-up menu. Then Data tab will be 

activated, the tracking information about each satellite of the selected 

observation file displays in the plan view as Figure 4-15.The interrupt 

part show  the  serious  unlocking  of  the receiver. 

 
Figure 4-15 
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The Tracking Satellite Map of Observation 

Chose one file in the Obs-Files tab of the detail view, right click on it, 

and chose Skyplot item in the pop-up menu. Then Sky Plot tab will be 

activated, the sky plot and SNR (Signal to Noise Ratio) plot about all 

the tracking satellites of the selected observation file displays in the 

plan view as Figure 4-16. 

 
Figure 4-16 

Transform Observation Data to the RINEX Format 

Choose one file in the Obs-Files tab of the detail view, right click on it, 

and chose Convert to Rinex item in the pop-up menu. Then the 

selected observation data files will be transformed to the RINEX 

format files(Figure 4-17).The property of RINEX file can via 

choosing Rinex Options item menu in the pop-up menu to set 

up(Figure 4-18). The created files are saved in the RINEX 

subdirectory of the corresponding project directory. You can view 

them by choosing Open Rinex Folder item menu. 
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Figure 4-17 

 
Figure 4-18 

Stop &Go RSP File  

If you do stop&go data processing, you need to add stop&go RSP File 

(stop&go time file) to dynamic file. Choose one file in the Obs-Files 

tab of the detail view, right click on it, and choose Add Stop&Go File 

item in the pop-up menu(Figure 4-19),then you can get it. Click on 

View Stop&Go RSP File to view RSP file you have added. 
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Figure 4-19 

Certainly, you can delete stop&go RSP File too, just chose Delete 

Stop&Go Info menu item in the pop-up menu. 

Observation Station 

Click on the Points node in the tree list view, and the right detail view 

will display information about site. There are two tabs in the right 

detail view, including points tab, control points. The control point list 

information is used to adjust network, and has nothing to do with 

baseline procession. 

 
Figure 4-20 
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The detail view lists each observation site name, fixed (whether the 

control points associated with it), spatial rectangular coordinate under 

WGS84 coordinate system and grid coordinate in local. 

Pop-up Menu of Observation Station 

Right click on the selected site, pop-up menu display as Figure 4-21. 

You can do some operation about site. 

 
Figure 4-21 

Property of Observation Site 

Chose Edit menu in the pop-up menu or double click on selected site, 

you can set the property of the observation site, such as its name, 

WGS coordinate, local grid coordinate. 

 
Figure 4-22 
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HGO software package record all coordinate source, such as 

observation file. You can change the coordinate source of site by 

selecting source in the source combo box and apply it by clicking 

Apply button. Certainly, you also can enter coordinate by clicking on 

Edit button. 

Baseline 

Click on the Baselines node in the tree list view, and the right detail 

view will display information about baselines (Figure 4-23). 

 
Figure 4-23 

Pop-up Menu of Baseline 

Click on the Baselines node in the tree list view, and the right detail 

view will display information about baselines (Figure 4-24). 

You can do operation about baseline by pop-up menu. Such as setting 

procession option, processing baseline, viewing report, delete 

baseline. 
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Figure 4-24 

Repeat Baseline 

Click on the Repeat Baseline node in the tree list view, and the right 

detail view will display information about repeat baseline (Figure 

4-25). 

 
Figure 4-25 
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Processing Options 

Before processing baseline, you should set processing options. Right 

click on one baseline, chose Process Option item in the pop-up menu, 

or click on  in the navigation filed, the following dialog display: 

 
Figure 5-1 

The dialog is consisting of four setting pages: General, Ion/trop, 

Dynamic, Advanced. 

General Setting 

For pure static baseline, the minimum epoch count is 5s, or 

observation data can't form the baseline; for dynamic baseline, the 

minimum epoch count is 180, or the integer ambiguity can’t be fixed. 

Cutoff Angle 

Cutoff angle is used to limit the satellite data with relatively lower 

height angle, these data won’t be processed when you processed 

baseline. 

The influence of atmosphere is more complex for the lower height 

satellite signal, it is difficult to use model to correct. In addition, the 

http://dict.youdao.com/search?q=influence&keyfrom=E2Ctranslation
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signal of lower height is respect by various factors, such as multi-path 

effect, electromagnetic waves. So the quality of these satellites signal 

is relatively worse, we remove them in the data procession. 

From the atmosphere refraction perspective, observation for a short 

distance can be reduced cutoff angle height; for long distance 

observation, it should to be increase the height of cutoff angle. The 

shorter the distance, atmospheric refraction affects is easier to cancel 

each other out. Of course, the setting of cutoff angle also depending 

on the observation stations for the surrounding environment. 

Observation in the field, we should choose lower height cutoff angle 

and collect more data according to satellite distribution. 

 
Figure 5-2 

The default cutoff angle is 20 in HGO software package. 

Sampling Interval 

The so-called epoch interval is the data interval taken from the 

original observational data drawn Take in the baseline process. 

For example: when two receivers are processing static surveying, they 

are set up to capture a group of data every 5 seconds. But when it 

comes to the inside processing, this high density data usually degrades 

the accuracy of the baseline processing, instead of increase. So in 

order to accelerate the processing rate, user can increase the interval 

time appropriately. Generally, for the short line, and the observation 

time is not long, you can reduce the interval time appropriately, while 

for the long line, you can increase the interval time. e.g. For a static 
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baseline shorter than 2 k, and the observation time within 20 minutes, 

then you can set up the interval to be 5seconds. But if the baseline is 

longer, you can increase the interval to be 60 or 120 seconds.   

Why set up so little interval surveying in outdoors? Because the 

randomicity of the Observations and the limit of the software, you can 

change the epoch interval then process the baseline again to get a 

better result when you have the worse data. The default epoch interval 

is 60 seconds.  

Minimum number of epoch  

Because the dual-difference is formed via the difference of the 

single-difference observations among the satellites, for simple 

processing purpose, the software fixes a reference satellite when form 

the dual-difference observation value. The default minimum number 

of epoch is 5. 

Observations (Frequency) 

You can choose different combinations of observed values to process 

baseline, such as wide lane Lw, narrow lane Ln and so on. When you 

choose auto mode, program can automatically select the type of 

observations according to the baseline length. Generally, baseline less 

than 5km use L1 observations, baseline greater than 5km use a Lc 

ionosphere-free combination observations. 

Ephemeris (Navigation) 

You can select the broadcast ephemeris or precise ephemeris to 

process. Generally, long-distance baselines use precise ephemeris can 

improve the accuracy of the baseline solution; for short-distance 

baselines, the broadcast ephemeris can meet the requirements. 

Reference Satellite 

The default of reference satellite is auto. As this mode, program will 

select the observation data of most and satellite elevation angle of 

higher as a reference satellite. 
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However, due to the influence of the conditions of observation, such a 

choice may not be the most reasonable .When the reference satellite 

selected is not reasonable, the results of the baseline processing will 

be affected. At this time, you need to reset the reference satellite based 

on observation data. 

Auto-Process Mode 

HGO software package has capabilities of automatically removing the 

gross errors in satellite data .It can help users to reduce the work of 

removing the data manually and make the baseline solution qualified 

in the shortest period of time. This feature can be enabled when the 

settings as the "enhanced". If the user wants to remove the data 

manually, just set to the "general".  

Dynamic Solving Mode  

This page is used to set dynamic route procession mode. Just used for 

dynamic route processing. Dynamic GPS data processing has three 

solving mode: RTD, Stop&Go, PPK (Post Process Kinematic). 

 
Figure 5-3 

Auto: Software will choose mode to process baseline according to the 

existence of stop&go RSP file. No RSP file, using RTD mode, or 

Stop&Go mode. 
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RTD: The solving method of integer ambiguity for RTD solution 

mode is pure dynamic method. It can achieve 5 m precision within 

300 kilometers and above 1m precision within 100 kilometers. 

Stop&Go: This solution mode is suitable for short, middle, long 

baseline processing. Both stop stage and go stage is processed 

according to the principle of least squares method. The solving 

method of integer ambiguity, for stop stage, is fast static method and 

for go stage, is pure dynamic method. The precision of solution mode 

has better repetition than PPK, because it only has one ratio value. 

PPK: This solution mode is suitable for short, middle baseline 

processing. Both stop stage and go stage is processed according to 

Kalman Filtering method. The solving method of integer ambiguity, 

for go stage, is pure dynamic method. For stop stage, integer 

ambiguity is obtained according to the dynamic single epoch 

results .The precision of this solution mode has less repetition, 

because every epoch has a ratio value. 

Notice: If the quality of satellites single is good, the result of 

PPK and Stop&Go is much same. But if the quality of 

satellites single is worse, you’d better choose PPK 

solution method. 

Ionosphere/ Troposphere 

In general, not need to change the troposphere, ionosphere settings. 

Long baseline can improve the solution setting precision according to 

actual situation. 
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Figure 5-4 

Advanced 

In general, the default value can satisfy the requirement, do not 

recommend that users to illegal change influence the solution the 

stability of the engine. 

 
Figure 5-5 

Baseline Processing 
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After the above setting, chose Baseline /Process line all baselines, or 

click on  in the navigation field, the software will process each 

baseline in sequence and display the information frame.  

The baseline is run in the multithreading mode in the backend. During 

the processing, click on Cancel button, then you can stop process 

baseline. 

 
Figure 5-6 

The baseline solution result will display in the message filed after the 

solution as Figure 5-7. 

 
Figure 5-7 
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If there is warning, click on one warning message and you will find 

the corresponding baseline in the list. The result of the solution can 

form the baseline report via chose Baseline->Report menu or click on 

 to create baseline report.  

Test Baseline Processing Result 

Control Baseline Quality 

After the baseline is resolved, you can test the quality of the baseline 

by the quality standards such as RATIO, RMS and the point precision. 

RATIO 

The RATIO is the ratio of the less least RMS and the Least RMS after 

the integer ambiguity analysis, that is:  

 

The RATIO reflects the reliability of the integer ambiguity parameter, 

which determined by a few factors. It has the relation to the 

observation quality and the observation term.  

The RATIO is the key to reflect the quality of the baseline, generally, 

the RATIO is required to bigger than 1.8.    

RMS 

RMS is the Root Mean Square, that is:  

 

V is the residual of the observations;  

P is the weight of the observations;  

n-f is that the total numbers of observations subtracts to the number of 

known number. 
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RMS means the quality of the observations. The smaller the value of 

RMS is, the better the quality will be; otherwise the worse the quality. 

The RMS does not effected on by the observation terms.    

According the theory of Symbolic Statistics Mathematical Statistics, 

the rate of the observation error within the 1.96 times RMS is 95%.    

Point Precision 

Point precision is an important standard of the internal accuracy of 

solution results. It is depend on line with the strength of the satellite 

geometry and RMS , it can be divided into the precision of horizontal 

direction, precision of the vertical direction, the baseline length 

precision and so on. The software will check the different accuracy 

standard according to tolerance setting of project. 

Closed Loop and Repeat Baseline Testing 

Closed Loop 

1. The Definition of the Misclosure  

The closed loop test is the useful way to confirm the quality of the 

baseline. The closed loop includes the synchronous loop, 

asynchronous loop and the duplicate baseline. In theory, the 

misclosure of the closed loop is zero, but in practice surveying a 

certain deviation is allowed. Please refer to the relation information 

about the deviation limit. 

The types of the misclosure are as the followings:  

 Component misclosure, that is : 

 

 Total misclosure,that is: 
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2. Synchronous closed loop  

The misclosure of the closed loop is the misclosure of the closed loop 

formed by the observation baselines. Because the relativity among the 

baselines, so in theory the misclosure should be zero. If the deviation 

of the misclosure out of the limit, then there is at least one baseline 

vector is wrong. Instead, if the misclosure is within the limit, this 

mean that most static baselines are eligible, but that is not to say all 

the baselines of the loop is absolute eligible. 

3. Asynchronous closed loop    

The asynchronous closed loop is the closed loop formed by not all the 

synchronous baselines. The misclosure of the asynchronous loop is the 

asynchronous loop’s misclosure. If the misclosure is within the limit 

of the deviation, it denotes the baseline vector to be eligible. If the 

misclosure is over the limit of the deviate, it denotes that at least a 

vector is not eligible. You can decide which baseline vector is not 

eligible by the vicinity asynchronous loop and the duplicate baselines.   

Repeated Baselines  

The observation result between two stations at different observation 

times is the repeat baselines. The difference between the repeat 

baselines is the repeat baselines comparability difference.  

Identify Every Effect Factors 

Effect Factors 

Factors effecting on the baseline’s result are as follows.  

1. The setting starting coordinate is wrong when you process the 

baseline. The wrong starting coordinate will cause the baseline 

deviation in the scale and direction.  

2. The too short observation time cannot decide the integer ambiguity 

of the satellite. And for the baseline processing, if the integer 



 HGO Data Post Processing Software Package Manual 

69 

ambiguity corresponding is not decided exactly, the baseline 

processing result will be effected.    

3. The number of the cycle slips is too big in some time span and 

cause the cycle slips repairing is not perfect.    

4. The multi-path effect is serious in an observation time span, and the 

corrections of the observation value are general big;  

5. The effect on the troposphere and ionosphere is too serious;  

6. The electromagnetic wave cannot be ignored.    

7. The receiver itself has problem and cause the quality of the data too 

bad. e.g. the degraded phase accuracy of the receiver and the clock of 

the receiver is not accuracy.  

Identify Effect Factors and the Answer Measures 

1. The identification of the effect factors on the GPS baseline 

resolution  

1) In the effect factors, some are easy to distinguish, such as the too 

short observation time, too many cycle slips, serious multi-path effect 

and too big effect from the troposphere or ionosphere. But other 

factors are not easy to distinguish, such as the inaccurate starting 

coordinate.  

2) The inaccurate starting coordinate  

Now we cannot distinguish easily the effect of inaccurate starting 

coordinate to the quality of the baseline solution. So we should 

improve the accuracy of the beginning coordinate to prevent this 

effect.    

3) The identification of the short observation time span  

You can distinguish this question easily. You can view the number of 

each satellite’s observations in the record files. The HGO Software 

Package supplies the visible satellite map.  

4) The identification of many cycle slips  
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You can analyze the observation residual of the baseline solution to 

distinguish the cycle slips. Now most baseline processing software use 

the dual-difference value, so when the observations include the 

uncorrected cycle slips, all the residual of the dual-difference 

corresponding to the cycle slips will have the obviously increase at 

several times.    

5) The Identification of the serious multi-path effect and the too much 

effect of the troposphere or the ionosphere refraction     

To the multi-path effect and the refraction of the troposphere or the 

ionosphere, we distinguish them by the residual of the baseline, too. 

But different to the integer cycle slips, when the multi-path effect and  

the refraction effect of the troposphere or the ionosphere serious, the 

residual increase within one time not several times and obviously 

bigger the normal residual.    

2. Answer measures 

1) The answer measures of the inaccurate starting coordinate    

To the inaccurate of the starting problem, you can use the most precise 

point as the starting point when you process the baseline. The relative 

accurate starting coordinate can be got by the long time point 

positioning or connecting with the more accurate the WGS-84 

coordinate, or do as the following way :  

When you resolve the baseline in a network, chose one point’s 

coordinate as the derivation of all the points’ coordinate, so it is the 

baseline’s starting coordination, then all the baselines have the same 

system error, so you can introduce the system parameter to resolve it 

during the network adjustment.  

2) The answer measures to the too short observation time    

If the observation time is too short, you can delete their observations. 

So you can improve the result of the solution via preventing them 

from solution.  

3) The answer measures to too many cycle slips  
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If in an observation time span, many satellites often have cycle slips, 

you can delete this time span to improve the solution quality.  If only 

one or two satellites have too many cycle slips, you can delete this 

satellite to improve the solution quality.  

4) The answer measures to the serious effect of the multi-path  

The result of the multi-path effect is the observation value residual too 

big, so you can delete the big residual observation value by reducing 

the edit dilution. Or you can delete the observation time or the satellite 

effected on serious by the multi-path. 

5) The answer measures to the serious effect of the troposphere or the 

ionosphere refraction:  

 Increase the elevation cutoff angel and delete the data of little 

elevation angel which is easy effected on by the refraction. But this 

method is blindly, because the signal of little elevation angle may 

not be effected mostly.  

 Modify the delay of the troposphere or the ionosphere by the 

model  

 If the observation value is dual-frequency, you can use the value 

without the fraction of the ionosphere.    

The Residual Map 

The residual map is a useful tool to condense the baseline processing. 

When you process a baseline, it is often to distinguish the factor of 

effect the solution or which satellite or in which observation time span 

has problem, the residual map is useful to this task. The baseline 

residual map is a figure expressing the residual of the observations. 

Chose the Previous or the Next , you can view the residual of the 

combination of each dual-difference. See Figure 5-8. 
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Figure 5-8 

This picture is a common format of the baseline residual map. The 

horizontal axes displays the observation time, the vertical axes 

displays the observation value residual. 

The residual value fluctuates with the zero axes in the common 

residual map, and the amplitude within 0.1 cycle. 

Reprocess a Baseline 

After you find the effect factors to the baseline’s quality, you can 

reprocess this baseline through correcting the baseline processing 

setting or editing the observation time span of the baseline.   

In the observation map, you can drag the mouse to select the deleted 

data. See Figure 5-9, the data in the broken lines box will be shielded, 

and will not be processed. 
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Figure 5-9 

When you find the processing is disqualified during the baseline 

surveying, you need correct the setting of the baseline or edit the 

observation time span. If you cannot get the qualified solution still, 

you should prevent this baseline from the network adjustment of 

delete this baseline. If the baseline is necessary in the control network, 

you should resurvey this baseline.  

Dynamic Route Processing 

The dynamic route post-processing is the post-difference data 

processing. The post-difference is different with the Real Time 

Kinematic which can get the surveying result at once, while the 

post-difference cannot get the result until the inner processing. If the 

post-difference processing cannot get the qualified result from the 

observations processing, there will be trouble. So the quality of the 

post processing software effects on the reliability and the quality of 

the post difference.  

The operation of dynamic route post-processing is very easy, just do it 

as dynamic route processing section of quick start guide chapter. Here 

we are not repeatedly introduced. 
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After you process the baseline, you should test again the result of the 

processing, optimize the result, and transform the coordinate to the 

needed national coordinate or the local coordinate, which is the 

content of the network adjustment. The method of this software 

network adjustment is the Least Square method. 

Function and Steps of Network Adjustment 

The Software has the function of processing the free network 

adjustment, the 3D constrained adjustment, the 2D constrained 

adjustment and the height fitting. 

See Figure 6-1, for the basic network adjustment steps for the HGO 

Software Package, from the map you can find that the network 

adjustment including three procedures. 

 The preparations done by the user. That is you need set up the 

coordinate, enter the latitude and longitude, the coordinate, the 

elevate of the known points; 

 Process the network adjustment which is done by the software; 

 The analysis and control to the quality of the processing result 

which are done by the user. Figure 6-1 The procedure of the 

network adjustment： 
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Figure 6-1 

We can find that, the software only achieves the solution of the 

network adjustment, what is more important is the attendance of the 

user and getting a right result. And this is often a procedure again and 

again.  

Network Adjustment Preparation  

Coordinate Setting 

You should check the setting of the coordinate before set up the 

network adjustment. The details of setting coordinate system, please 

reference Set the coordinate Parameters section of Project 

Management chapter. 

Network Adjustment Setting 

Chose Adjust /Adjust options menu or click on in the navigation 

field, the following dialog will display as Figure 6-2, you can set 

adjustment parameters and test parameters. 
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Figure 6-2 

Control-point Coordinates 

After network adjustment setting, you need to enter control-point 

coordinate, or you cannot do constrainted adjustment. There are 

several methods to enter the control-point coordinate: 

1. Click on Set as Control Point in the pop-up menu of sites list to set 

the site to control point. 

 
Figure 6-3 

2. Click on Set as Control Point in the pop-up menu of control point 

list to enter the control point info. 
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Figure 6-4 

3. Click on Import Control Point File in the pop-up menu of control 

point list to import the existing control point file to the project. 

 
Figure 6-5 

After entering control point info, you can click on Save to Control 

Point File in the pop-up menu of control point list to save control 

point file . 

Run Network Adjustment 

Run Adjust in the Adjust menu, or you can click on  button in the 

navigation field. Generally, just choose auto adjust mode, the software 

will process network adjustment based on the known baseline 

processing result, the network adjustment setting, the observation 

point’s coordinate. After adjustment, the software will form the 
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adjustment results list, select an adjustment result, then click on 

Report, you can view the correspond adjustment report. 

 
Figure 6-6 

Get Baseline Vector Network    

The first step to run the network adjustment is getting the baseline 

vector network. The principle to form the vector is as the following:  

1．This baseline in this project and it is not be deleted;  

2．This baseline with the starting name and the calculation name;  

3．Have resolved this baseline and display the qualified baseline in the 

vector list ;  

4．This baseline is not set up to not attend the solution and the network 

adjustment.  

The baseline with the above items will be downloaded in the first step 

of the network adjustment and form a baseline vector network.   

Check Connectivity of Baseline Vector Network 

If you process the adjustment with the network not connective, then 

the result of the adjustment can not converge. So the software will test 
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the connectivity of the network automatically before the adjustment. If 

the map is not connective, you will find the message information as 

Figure 6-7: 

 
Figure 6-7 

So you should test the baseline vector, the observation point name of 

the baseline vector network. The step to check as the following  

1. Firstly, check the map is divided into how many parts and it has the 

separated observation sites or baseline or not, if it has, you should 

delete the separate point or process baseline respectively.    

2. Secondly, make sure the key baseline is resolved successfully, and 

it is not prevented from the network adjustment. You should reprocess 

or resurvey the key baseline if it is in the above situation.  

3. Thirdly, make sure no observation site with two difference names, 

which reflecting to the map is that a site is too near to the other site. 

Because this two point observation is observation of the same site at 

different time span, so they can not form a baseline and the map is not 

connective, the answer measure is to modify the error station name in 

the observations property.    

Adjustment Report 

The results of the adjustment will be reflected in the report, 

Adjustment report content and display form can be set in the Adjust 

Report Options window (Figure 6-8).A free network adjustment, for 

example, to get the Web version of the adjustment results are as 

Figure 6-9. 
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Figure 6-8 

 
Figure 6-9 

Test Network Adjustment Result 

You should check the result of the network adjustment after the 

adjustment. You should test the corrections, the mean square error and 

the corresponding data statistics result to evaluate the quality of the 

network adjustment.   
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The net adjustment of mathematical statistics test includes the X2 test 

and Tau Detesting. 

X2 test showed the reliability of the results of adjustment. If the X2 

test value is less than the theoretical value range, it indicates that 

adjustment results of the error is smaller than the theoretical error. 

That is , the adjustment results are better than imagined, and generally, 

do not need to deal with or select the appropriate "baseline standard 

deviation confidence level (relaxation factor) to make the X2 test 

qualified; If the X2 test value is greater than the theoretical value 

range, the error of the adjustment results exceed the allowable range, 

it should be the baseline solver of error is too large or the control point 

information has  the existence of gross errors, you should find the 

problem with baseline or control points, and process again until test 

passed. 

Tau test is used to test the existence of gross errors gross error in the 

baselines involving adjustment. Generally, the test result depends on 

every baseline corrections. If a baseline Tau test cannot be passed, you 

need to process baseline again and then make it participate in the 

adjustment, or disable the baseline directly. 

If the result of the network is disqualified, you can find the cause from 

the following aspects.  

1. Make sure the coordinate setting is right;  

2. Make sure the known point is correct and in the same system;  

3. Make sure the baseline vector map is correct. For a disqualified 

static baseline, you can prevent it from network adjustment. If this 

baseline cannot be deleted or is very important in the baseline network, 

so you need resolved this baseline again or necessarily to resurvey 

again;  

4. Make sure the observation site and antenna height is correct in the 

observation files. If it is wrong, the misclosure or the result of the free 

network adjustment is very bad.  

http://dict.youdao.com/search?q=qualified&keyfrom=E2Ctranslation
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Of course, you can delete the bad quality observations directory. 

Because duplicate baseline to this deleted line can be found when do 

network adjustment, without the deleted baseline, the structure of the 

network is not effected on. After you delete and reprocess the baseline, 

you will get the same qualified result.  

Commonly if the map is qualified and the baseline solution accord 

with the standard requirements, it can pass two tests and complete 

successfully the 3D free adjustment.  
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In this chapter, we will introduce the detail context of various reports. 

Static Baseline Processing Report 

The static processing report consists of reference, rover, processing 

controls, tracking, baseline solution, ambiguities. 

 
Figure 7-1 

Reference and Rover Info 

It records the reference point/rover info, such as name, code, the 

spatial rectangular coordinate under WGS84 coordinate system, 

geodetic coordinate under WGS84 coordinate system, receiver info 

and Antenna info. 

 
Figure 7-2 

Processing Control 

WGS84 spatial 

rectangular coordinate 

WGS84  geodetic 

coordinate 

Receiver Info 

Antenna Info 
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This part mainly record the observation start time of baseline and end 

time some processing control parameters which you set in the 

procession options window. 

Ambiguities 

This part records the status of integer ambiguities solution, such as the 

following figure:  

 
Figure 7-3 

Network Adjustment Report 

This report is generated by network adjusting. Here we just introduce 

one report with free adjustment method. 

 
Figure 7-4 

The header of report is the result of adjustment test. You can know the 

adjustment result by these values. For example the test result in the 
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following figure, it is obvious that the X2 Test result is not in the 

range, it is not passed. When the x2 Test value is false, you need to 

check the baseline according to above chapter. 

 
Figure 7-5 

If the result of the network is disqualified, the baseline of problematic 

vector will be highlighted in red as Figure 7-6. You need to check the 

baseline according to above chapter. 

 
Figure 7-6 

Dynamic Route Processing Report 

It is a dynamic route processing report. There are three types report: 

RTD report, Stop&Go report and PPK report. The context of whole 

report is very clear. RTD report includes three parts: Reference point 

info, Coordinate system parameters and the every point info of rover. 

And the stop&go report and PPK report has stop point info besides 

RTD report context. 
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From the above chapters, it is obviously that the HGO Software 

Package has the strong function but simple operations. In this chapter, 

we will introduce the import and export function of the software.    

The HGO Software Package now can supply the abundance function 

of the import and export. Commonly, the output part content will be 

hand in, as a part of the result, when you hand in the result text.    

Import and Export Observations and Ephemeris 

For imported observations, we can convert them to RENIX file by 

choosing Convert to RINEX item in the pop-up menu (Figure 9-1). 

 
Figure 8-1 

You can select  in the navigation to batch conversion (Figure 8-2). 

The export achievements are in the "Rinex" folder under project 

folder. 

 
Figure 8-2 
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Export the Coordinates of Result Points  

In above window, chose Points Files item to export. You can get the 

coordinate of result point of TXT format. 

The coordinate of point is separated by ‘,’ symbol: 

Point name, Latitude, Longitude, Ellipsoidal Height, Northing, 

Easting, Normal Height 

 
Figure 8-3 

Export Network Map 

HGO software package can export Network Map with DXF format. 

Chose Project Plot DXF item to export Network Map . 

 
Figure 8-4 



 HGO Data Post Processing Software Package Manual 

91 

Notice: If use CAD software open can't see graphics, is 

perspective needs to adjust, please type the 

command e, z in CAD software, it will 

automatically zoom to effective graphics view 

area. 

Export Baseline Result 

HGO software package can export baseline result as Figure 8-5. After 

exporting, click on Folder button, you can view the corresponding 

format baseline result. 

 
Figure 8-5 

Export Report  

HGO software package can export project report with format: TXT, 

DOC, HTML 

http://dict.youdao.com/search?q=corresponding&keyfrom=E2Ctranslation
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Figure 8-6 
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The Common tools software of the HGO Data Processing Software 

Package include the antenna manager, the satellite prediction software, 

the Coordinate transformation tool, and the Precise ephemeris 

download tool.This chapter mainly introduces the using method and 

the answer to the common question. If you select All Install while 

install the software, the above tools software will be installed in the 

Bin directory of the software, and supplies the shortcut method.  

Usage of Antenna Manager 

Antenna manager is designed for updating and editing the receiver 

parameter file(The "HitAnt. Ini" file). When you used the unknown 

receiver type but know the geometric parameter of the receiver and 

the phase center height parameters, you can use this tool to add the 

receiver you needed. 

Chose Tools-> Receivers in the menu, there will be pop-up window, 

in the Antenna item,  you can set up some commonly used 

parameters here,  such as the radius, the phase center height. See 

Figure9-1: 

 
Figure 9-1 
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In the list window, chose the name of the antenna, you can change the 

corresponding parameters direct. 

Notice：This file would influence the data 

achievement, please don’t change it easily! 

Coordinate Transformation Tool 

The HGO Data Processing Software Package supplies the coordinate 

transformation tool. Choose Coord Tool in the Tools menu to function 

the coordinate transformation tool. 

This software can transform between the local coordinate and the 

WGS84 coordinate, meanwhile it can calculate the parameter. The 

following is about these tools in details: 

Summarize 

Firstly, you should know the representation of each coordinate. The 

common methods are the Longitude-Latitude and Ellipsoid Height 

(BLH), the Space Rectangular Coordinate (XYZ), the Plane 

Rectangular Coordinate and the Geoidal Height (xyh/NEU). The 

ellipsoid height is a geometric sense and the geoidal height is a 

physical quantity. 

The WGS84 is of the BLH system, the Beijing 54 is of the Plane 

Rectangular Coordinate.  

Now it comes to the accuracy of the transformation. In an ellipsoid, 

the transformation is rigor(BLH--XYZ), but the transformation in 

different ellipsoid is not rigor. e.g. There is no a transformation 

parameters can be used all over the national between the WGS84 

coordinate and the Beijing 54 coordinate, because the WGS84 

coordinate is a geocentric coordinate system, but the Beijing 54 

coordinate is a local geodetic reference system. The elevation’s 

transformation is between geoidal height and physical quantity. So in 

each place must use local ellipsoid fitting, usually with seven 

parameter model to fitting. 
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Generally, the more rigor method to transform coordinate between 

different ellipsoid is the seven parameters transformation. That is the 

X plane, the Y plane, The Z plane, the X Spin, the Y spin, the Z spin 

and the Scale Dilution K. For getting the seven parameters in a 

location, you should have more than three points. If the area is not 

large, the furthest point is within 30km, and you can use the three 

parameters, that is X plane, the Y plane, and the Z plane. The X spin, 

the Y spin, the Z spin and the Scale Dilution K are regards to be zero. 

The tree parameters are the special of the seven parameters. 

The essence of the seven parameter model with a local ellipsoid to 

fitting the form of local coordinate system; so the local ellipsoid 

height after transformation is the geoidal height. Of course, we can 

also fit it in the different direction of plane and elevation. For example, 

using the four parameter model fitting in the plane, and using the 

secondary surface model fitting in the elevation direction. This mode 

of handled separately is more freedom than seven parameter model. 

But because the four parameters model has less parameter, a weak 

ability of expression, usually uses for small regional coordinate 

transformation. 

To sum up, the HGO coordinate transformation tool provides two 

practical transformation strategies to choosing by the customers: 

1. Seven parameter model, one step to get local plane and level data. 

2. Four parameters and elevation fitting model, which is divided into 

two steps to get local plane and level data. 

Because each company has a different definition of the model and 

process, here is our company's conversion process, its description as 

follows: 

 the conversion process of seven parameters model is like this: 
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Figure 9-2 

 the conversion process of four parameters model is like this: 

 

 

 

 

 

 

 

 

 

 

Figure 9-3 
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 the conversion process of elevation fitting is like this: 

 

 

 

 

 

 

 

 

Figure 9-4 

Use Software to Transform Coordinate 

This software manages the coordinate transformation parameters with 

file(*.dam), you can save a group of transformation parameters as a 

file, and next time you can open this file to transfer the parameters in 

the file menu.  

Involves the coordinate transformation parameters are generally refers 

to the ellipsoid parameter, projection parameters, seven parameters, 

four parameters, elevation fitting parameters, level grid files. All these 

parameters’ input integrated to the interface as follow. After input the 

parameters, input a file name, and click on Save button , will create a 

“*.dam” parameter file in the “GeoPath” directory which in the 

“Program” folder. 

Click the Parameter menu: 

WGS-84  B and L 

Several  known  

point 

WGS-84  Plane 

 Rectangular 

Elevation fitting 

Local  geoidal  

height 

Coordinate  projection 

Calculate fit  

parameters 
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Figure 9-5 

In the interface, complete inputting parameters, or click [V] 

drop-down button to select a file of coordinate transformation, then 

click on the Ok button, will get back to the main interface to positive 

and inverse transform coordinate: 

 
Figure 9-6 
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Parameter Calculation 

When users have a group of control points (these points have both 

WGS84 coordinate and local coordinate), you can use this software to 

calculate the parameters. As previously mentioned, this software 

provides seven parameters model and four parameters and elevation 

fitting model solution, the calculation of two models is completed in 

the same interface, it’s convenient to users to compare and choose 

different precision model. In the main interface, click the Parameter 

Clac in the Tools menu, can open the parameter calculation interface 

(if you have not input the ellipsoid and projection parameters, there 

will be prompted and pop-up the “Parameter” interface). 

The process of parameter calculation is: 

1. Input basic parameters: First, input local ellipsoid and projection 

parameters. 

2. Import data: Add points coordinate one by one or to one data, or 

prepared the text file first then click the Open button (prepare note: 

file format is [Name, B, L, H, x, y, H]). 

3. Calculate parameters: The software support two modes of 

coordinate transformation, click the Calc Bursha Parameter or Calc 

Helmert 2D + Height, if use the second mode, please selected the 

model of elevation fitting firstly. 

4. Check the result: In the result bar will show the calculated 

parameters, the user can copy and save them. 

5. Use parameters: Click the Parameter settings button, check the 

transformation parameters, the ellipsoid parameters and the projection 

parameters. Make sure these are correct, then you can input a name 

and save as a “*.dam" file, this file also can be used in other Hi-target 

software.  
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Figure 9-7 

Notice：Please switch to the Map view and check the 

geometric distribution of the points used to 

calculation (Avoiding the points are presented a 

linear distribution, lead to the parameters has 

poor applicability and stability.  

Satellite Prediction Software 

The HGO Data Processing Software Package supplies the Satellite 

Prediction software. Choose Star Report in the Tools menu to 

function the Satellite Prediction software. 

Satellite prediction is to forecast the distribution conditions of 

satellites at a certain time in a certain area according to the satellite 

almanacs data collected by receivers. So that observers can choose 
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proper time to do fieldwork, which will make the fieldwork more 

effective and the data better. 

The general step of this software using is as follows: 

1. Update historical data; 

2. Set stations’ position and time, elevation angle; 

3. Forecast, check the number of satellites, check the sequence chart 

of DOP value, choose the measuring time. 

Input Almanacs Data (Yuma format) 

Yuma is a kind of almanacs data format broadcast on internet by 

America. GPS users all over the world can download the latest 

almanacs data on the specific official website: 

http://www.navcen.uscg.gov/ftp/GPS/almanacs/yuma/ 

Select Download Yuma (GPS) in the Help menu, the software will 

download the latest Yuma files, save it automatically and show you 

“download finished”. See Figure9-8: 

 
Figure 9-8 
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Observation Station Coordinate and Observing Period 

Setting 

After the latest almanacs data loaded, you need to set up the station 

BL, height, height cutoff angle, observation period and so on, which 

will enable the software to calculate the parameters.  

You can set up the date in Status window. The default one is the date 

of computer system. Users can choose any day by “reviou”, “Today”, 

“Next”, “Manual”. See Figure9-9: 

 
Figure 9-9 

Click Setup ->Option… to set up the station BL, height, elevation 

cutoff angle, observation period. See Figure9-10: 
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Figure 9-10 

The BL coordinate need not the precise value, with 1~2 km precision 

will be ok. Users who do not know the BL coordinate can get it as 

follows: 

 With attached coordinate transformation software, users can 

transform the XYZ of the known point to BLH and then input them 

into the software to do satellite prediction.  

 Get the BLH format coordinate by specific GPS instruments as 

HD8100, HD8088, HD8800 and the like, then input the BLH into 

the software to do satellite prediction. 

Pay more attention to the selection of the local time and GPS time 

when you set up the observation period. And confirm the difference 

between local time and UTC time when you input the observation 

period in local time setting. Usually the computer will suggest you to 

choose time zone while installing. For example, Beijing time is 8 

hours ahead of the UTC time (international standard time). If none of 

“local time” input, the default one is Beijing time.  

As usually, when setting the observation period, please make sure that 

the difference between the start time and the end time is several hours 

to 24 hours while the start time is always ahead of the end time. See 

Figure9-11: 
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Figure 9-11 

The angle will limit the azimuths of the prediction satellites in the way 

that only the satellites whose azimuths are over the setting one can do 

the prediction. Sampling rate control the data output interval. The 

smaller the sampling rate, the more detail the data are. See 

Figure9-12: 

 
Figure 9-12 

Satellite Status Prediction 

After input the observation station coordinate and the observing 

period and the click on ok button, you can check the satellite status in 

any view window of the software.  
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1. Export satellite detailed status Click button See Figure9-13: 

 
Figure 9-13 

2. Satellite tracking map  

Satellite tracking map shows the change of the number of the visible 

satellites with the time elapsing in the limited period. With the map, 

users can choose the period when the visible satellites are more to do 

observation so as to improve the fieldwork. Click  button. See 

Figure9-14: 

 
Figure 9-14 
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3. Constellations map  

Constellations map shows the distribution conditions and the 

movement of satellites at a certain time in a certain area.  For 

example, in the Figure (click ), the satellite 32 will travel northwest 

to south in prediction. And the map shows the BL coordinate as well 

as the observing period. 

 
Figure 9-15 

4. Number of the visible satellites and the PDOP 

Click  the relationship of the satellites number and the time will 

show in upside map while the PDOP will show in the downside map. 

The PDOP denotes how the positioning accuracy acts on satellites 

distribution. See Figure9-16:  
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Figure 9-16 

5. World map  

Click , you can see the satellites traveling tracks in the world map. 

See Figure9-17: 

 
Figure 9-17 

6. Print out  

File shows, satellite number, PDOP value and satellites distribution all 

can be print out.  

Update Ephemeris Data  
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To predict satellites precisely, the ephemeris data should be updated 

often, suggesting no more than one month once. The inner-set of the 

software enable it to suggest users to update when necessary. 

Precise Ephemeris Download Tool 

In order to improve the precision of the static data processing software, 

you can download SP3 precision ephemeris data from the product FTP 

server which provided by the United States IGS. This tool is 

developed for automatic download the data rapidly and easily from the 

data server, is very easy to use, to select the data date and data types, 

click Start to download. 

 
Figure 9-18 

Notice ：In the entire world, there are multiple FTP 

servers provide data download service. Please 

according to your network circumstance, 

choosing a suitable download site to download 

the data. 

 


	Installation and Uninstall
	Software component
	Installation
	Uninstall

	Quick Start Guide
	Static GPS Data Processing
	Create a new project
	Set Property of the Project
	Set up Coordinate System

	Import Static Data
	Edit Files Information
	Baseline Processing
	Adjustment Setting
	Network Adjustment
	Report

	Dynamic Route Processing
	Import Data
	Set Property of Observation Files and Points
	Set the Mode of Observation Files
	Edit the Coordinate of Points

	Add Stop&Go RSP File
	Dynamic GPS Data Solution
	Processing Settings
	Process Baseline

	Report


	Program Main Interface
	HGO Main Program
	Menu and Toolbars
	Menu
	Tool Bar

	Navigation Field
	Plan View
	Observation Site
	Baseline
	Error Ellipsoid
	Graphical Operation Tools
	Setting the Drawing Mode of Plan Grid Reference Line

	Tree List View of Work Field
	Detail View of Work Field
	Property Window


	Project Management
	Create a New Project
	Set the Property of a Project
	Base Information
	Tolerance
	Advance

	Set the Coordinate Parameters
	Set Ellipsoid
	Set Projection
	Set Conversion


	Observation File
	The Content of the Observation File
	The ZHD/GNS Format Observations of Hi-Target Receiver
	The Observation in the RINEX Format
	Other Observation Format

	Data Preparation
	Import Data

	Name of Observation File
	ZHD/GNS Observations Files
	Rinex Observations Files
	Other Observation Files

	Pop-up menu of the Observation File
	Property of Observation File
	Single Point Positioning Result of Observation File
	The Data Track Map of Observation
	The Tracking Satellite Map of Observation
	Transform Observation Data to the RINEX Format
	Stop &Go RSP File

	Observation Station
	Pop-up Menu of Observation Station
	Right click on the selected site, pop-up menu display as Figure 4-21. You can do some operation about site.
	Property of Observation Site

	Baseline
	Pop-up Menu of Baseline

	Repeat Baseline

	Baseline Processing
	Processing Options
	General Setting
	Cutoff Angle
	Sampling Interval
	Minimum number of epoch
	Observations (Frequency)
	Ephemeris (Navigation)
	Reference Satellite
	Auto-Process Mode

	Dynamic Solving Mode
	Ionosphere/ Troposphere
	Advanced

	Baseline Processing
	Test Baseline Processing Result
	Control Baseline Quality
	RATIO
	RMS
	Point Precision

	Closed Loop and Repeat Baseline Testing
	Closed Loop
	Repeated Baselines

	Identify Every Effect Factors
	Effect Factors
	Identify Effect Factors and the Answer Measures
	The Residual Map


	Reprocess a Baseline
	Dynamic Route Processing

	Network Adjustment
	Function and Steps of Network Adjustment
	Network Adjustment Preparation
	Coordinate Setting
	Network Adjustment Setting
	Control-point Coordinates

	Run Network Adjustment
	Get Baseline Vector Network
	Check Connectivity of Baseline Vector Network
	Adjustment Report
	Test Network Adjustment Result


	Report
	Static Baseline Processing Report
	Reference and Rover Info
	Processing Control
	Ambiguities

	Network Adjustment Report
	Dynamic Route Processing Report

	Import and Export
	Import and Export Observations and Ephemeris
	Export the Coordinates of Result Points
	Export Network Map
	Export Baseline Result
	Export Report

	Using of Tools Software
	Usage of Antenna Manager
	Coordinate Transformation Tool
	Summarize
	Use Software to Transform Coordinate
	Parameter Calculation

	Satellite Prediction Software
	Input Almanacs Data (Yuma format)
	Observation Station Coordinate and Observing Period Setting
	Satellite Status Prediction
	Update Ephemeris Data

	Precise Ephemeris Download Tool


